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Editing is storytelling. It’s choosing from a sometimes vast 
array of video and audio clips and assembling them into 
a coherent experience that can educate, excite, motivate, 
or move viewers. Built on that fundamental truth of video 
editing, Final Cut Pro X enables a rich workflow that per-
mits you to approach editing as a storyteller, rather than an 
equipment technician. The goal of this book is to guide you 
through that creative workflow, structuring and refining a 
complete storytelling project from start to finish. Along the 
way, you’ll learn features and acquire skills to realize high-
quality editorial results using Final Cut Pro.

For the new editor, Final Cut Pro will help you tell your story 
without the technical frustrations you may have experienced 
with other video editing systems. For the seasoned editor, 
Final Cut Pro can reinvigorate your editing creativity with 
unique features such as the innovative Magnetic Timeline 2, 
which encourages you to experiment with your story and 
make complex editorial changes while eliminating the neces-
sity to micromanage individual clips and their relationships.

Lesson 1

Getting Started

GOALS

▶▶ Download and prepare 
lesson media files

▶▶ Understand basic Final 
Cut Pro workflow
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Welcome to Final Cut Pro X.

Learned from a Legacy
Just as offline digital editing once revolutionized traditional splice-and-tape techniques, 
Final Cut Pro aims to take digital editing to the next level. As cutting-edge programming, 
Final Cut Pro uses the power of 64-bit architecture and every cycle of the CPUs and GPUs 
to realize breathtaking performance. When combined with an iMac Pro, Final Cut Pro 
dramatically accelerates a professional editing workflow.

As an editing suite, Final Cut Pro is the foundation of an experience that naturally carries 
you from one creative choice to the next, rather than becoming mired in technical tasks. 
In addition to its powerful editing capabilities, Final Cut Pro incorporates flexible meta-
data tools that help you organize the increasing quantity of media an editor must organize 
in today’s digital world. And when editing is completed, you’re able to distribute your final 
projects to whichever format or platform your client or audience requires. The result is a 
forward-looking application that removes conventional stumbling blocks so that all edi-
tors can create and share their stories using the highest-quality software and hardware 
available.
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All clips synchronized with a primary storyline clip follow along  
without clip collisions in the Magnetic Timeline 2.

Reference 1.1 
Using This Book
This book is available in multiple formats. The electronic versions may include enhanced 
content such as:

▶▶ Glossary: Click/tap words that appear glossary styled to review the term’s definition.

▶▶ Keyboard shortcuts: Click/tap keyboard shortcuts (such as Command-Z) to jump to 
Appendix A, which includes an abridged list of over 300 commands that you may 
assign to keyboard shortcuts.

▶▶ Links: Click/tap links to view internal and external cross-referenced information 
sources.

NOTE ▶   Due to technical differences between various ebook formats and platforms, 
some of the digital features described are not available in all formats.

1.1-A Performing the Exercises
The exercises in this book build on each other from Lesson 1 to Lesson 8. You are advised 
to complete each exercise (starting with Exercise 1.1.1 in this lesson) before attempting the 
next exercise, and to move through each lesson before proceeding to the next.
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1.1-B Verifying Your Progress with Checkpoints
At the conclusion of major exercises and lessons, you’ll find a checkpoint reference. These 
checkpoints are the author’s version of the completed exercise, which you can compare 
with your version. Refer to Appendix C for more details on downloading and using this 
learning tool.

Exercise 1.1.1 
Downloading the Source Media Files
The source media files you’ll use throughout the book are available for download from 
Peachpit Press. They are organized into zip-compressed files that automatically unzip after 
download unless you have changed your browser’s preferences.

To download these files, you must register your purchase on peachpit.com in order to 
access the online content:

1	 Go to www.peachpit.com/register.

2	 Sign in or create a new account.

3	 Enter the ISBN: 9780135171738.

4	 Answer the questions as proof of purchase.

5	 The Lesson Files can be accessed through the Registered Products tab on your 
Account page. Click the Access Bonus Content link below the title of your product to 
proceed to the download page.

6	 Click the lesson file links to download them to your computer.

After downloading the zip files from the website, you are ready to proceed with the 
following exercise.

NOTE ▶   After redeeming your access code, that code is saved in your Peachpit.com 
account. You may log in to your Peachpit.com account to re-download the zip files 
later, if necessary.

http://peachpit.com
http://www.peachpit.com/register
http://Peachpit.com
http://Peachpit.com
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Exercise 1.1.2 
Preparing the Source Media Files
After downloading the zip files, you will place the files into a folder that you may create in 
any location you have permission to access. Examples of an accessible location to which 
you may read/write files are: the desktop, home folder, or Movies folder. If you have an 
external volume you’d like to use, ensure that the volume is set up in a supported format 
such as HFS+, that you have read and write permissions for the volume, and that the vol-
ume is on a fast storage device such as a 7200 RPM hard disk or solid-state disk with a 
minimum 10 GB of available storage space.

1	 In the Dock, click the Finder icon to open a Finder window.

The Finder is an application used to navigate your Mac computer’s filesystem.

2	 Choose where you’d like to store the downloaded media.

Every video production begins with the acquisition of media files. You start this pro-
cess for the exercises in this book when you download the book’s media files. Because 
you will need to access those files to complete the exercises, you should gather and 
organize them in a media folder.

If you aren’t sure where to create the media folder, a great folder location to use for 
training purposes is your desktop. If you currently store your Desktop and Docu-
ments folders on your iCloud Drive, you must select a local folder—such as your 
Movies folder—to store this book’s lesson files and any Final Cut Pro libraries you 
may create.

3	 In the Finder window, navigate to your chosen storage location, such as the desktop.
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4	 Choose File > New Folder.

A new, untitled folder is created with its name highlighted, ready to be renamed.

5	 Type FCP X Media, and press Return.

The FCP X Media folder appears, ready to store the downloaded files. To do so, you’ll 
open a second Finder window so you can drag the media files to the newly created 
FCP X Media folder.

6	 Choose File > New Finder Window.

A second Finder window appears.



Exercise 1.1.2 Preparing the Source Media Files    7

7	 Choose Go > Downloads.

The second Finder window displays the Downloads folder contents.

8	 For convenience, arrange the two windows side by side on the desktop.

9	 From the Downloads folder, drag the following files/folders to the FCP X Media 
folder: Checkpoints, GoPro SD Card 1.dmg, LV1, LV2, and LV3.

After moving the files to the FCP X Media folder, you may verify the move by clicking 
the disclosure triangle to the left of the FCP X Media folder and viewing the folder’s 
contents.
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NOTE ▶   If any of the files/folders end with the extension .zip, double-click the file to 
unpack its contents.

10	 Close both Finder windows.

Throughout this book, the exercises will reference the FCP X Media folder and its 
contents. You’ll need to remember where you saved the folder when accessing its con-
tents within Final Cut Pro.

Reference 1.2 
Introducing the Job and the Workflow
All books need a story, and in this book two production companies, H5 Productions and 
Ripple Training, recorded sound bites and B-roll for a video about aerial cinematography. 
As an editor, you’ve agreed to cut a 1:30- to 2-minute vignette for them about H5’s owner 
and helicopter pilot, Mitch Kelldorf, and his passion for flight and film.

In the first four lessons of this book, you will edit a first version “rough cut” using the 
same real-world workflow that thousands of Final Cut Pro editors follow. At the end of 
Lesson 4, you will export your rough cut to “show to the client.”

The rough cut at the conclusion of Lesson 4

Starting in Lesson 5, you’ll implement the client’s suggested changes and insert additional 
material. You’ll finesse the rough cut with additional edits, and then move into the sweet-
ening tasks of adding titles, effects, and speed changes. Finally, you’ll turn your attention 
to refining the audio mix before you examine the share options for exporting the project.
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The finished edit at the conclusion of Lesson 8

Lesson 10 describes “sub-workflows” you can use to replace or supplement your edit-
ing workflow. Among these are techniques for synchronizing clips recorded in a dual-
system setup, used often in HD-DSLR setups, and editing clips recorded in a multicamera 
scenario.

1.2-A Learning the Workflow
When you look at the Final Cut Pro editing workflow from the 30,000-foot level, you see 
three phases: import, edit, and share.

During the import phase—sometimes referred to as ingest or transfer—you process source 
media files into clips. Then, those clips are stored and organized in preparation for the 
edit phase.

Organizing clips within an event
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The edit phase—where you’ll spend most of your time with Final Cut Pro—is when the 
magic begins. This phase comprises several sub-workflows, including trimming clips 
down to the best material, adding graphics, and mixing the audio.

Adjusting audio keyframes

The share phase is when you prepare your finished editing project for distribution to vari-
ous online hosts or clients, for playback on a variety of devices, and for final archiving.

Entering metadata for export

That’s the high-level Final Cut Pro workflow within which you will build your stories. As 
you continue through this book, you’ll learn the many tools and techniques, the buttons 
and keyboard shortcuts, you’ll use again and again during your editing workflow. So as 
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you begin this editing odyssey, start by committing one keyboard shortcut to memory: 
Command-Z. If you click a button or press a key and don’t get the expected result, just 
press Command-Z. Then, try the edit again. Don’t be afraid to experiment. Final Cut Pro is 
built to encourage exploration of all your editing options and all your creativity.

Lesson Review

1.	 Define the three post-production workflow phases in Final Cut Pro.

2.	 Describe the device recommendations for storing source media files.

3.	 Describe the volume formatting and access recommendations for a media storage 
device.

Answers

1.	 Import: The process of ingesting and storing your story’s source media files, and 
organizing the clips that represent those source files. Edit: The creative process of 
assembling, trimming, and effecting clips to tell a story. Share: The export process of 
outputting your completed story for various distribution platforms and formats.

2.	 Media files should be stored on a fast storage device such as a 7200 RPM or greater 
hard disk or a solid-state disk.

3.	 A media storage volume should be formatted in a supported format like HFS+ and be 
read and write accessible.
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You perform the Final Cut Pro post-production preflight, or 
pre-edit, during the import phase of your workflow. Devot-
ing some time to media management and clip organization at 
the beginning of your editorial process pays off heavily dur-
ing the later phases of an edit. As part of the import process 
described in this lesson, you will bring media files into the 
application as clips that you’ll use for your project. Before 
you start the import process, however, you must be familiar 
with the clip organization structure of Final Cut Pro.

Reference 2.1 
Understanding Clips, Events, and Libraries
The Mac operating system, macOS, uses nested folders on a 
storage volume—such as a hard disk—as containers in which 
you store, manipulate, organize, and share content.

Files are enclosed in a folder stored on a volume.

Lesson 2

Importing Media

GOALS

▶▶ Define the clip, event, 
and library containers

▶▶ Understand the differ-
ences between managed 
and external media files

▶▶ Create a camera archive

▶▶ Import files using 
Media Import and 
the Finder
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Similarly, Final Cut Pro uses specialized clip, event, and library containers to store and 
organize your media.

Clips are enclosed in an event stored in a library.

2.1-A The Clip Container
After acquiring source media files, such as those you downloaded in the previous lesson, 
you will import them into Final Cut Pro for editing. The import process creates a clip 
inside Final Cut Pro that represents each source media file. Each clip varies in its contents: 
Some combine audio and video content, others contain only video or audio. Think of each 
clip simply as a container. To edit a video file, you must import the file into Final Cut Pro. 
Final Cut Pro places the file’s contents into a clip container.

The clip container references  
a source media file.

2.1-B The Event Container
Clips within Final Cut Pro are virtually organized into larger containers called events. 
Events may contain a wide variety of clips, but are best utilized to organize clips that 
have one or more common elements. A common element could be interviews, shots for 
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a movie scene, or stock footage. The event container can include a varied cornucopia of 
clips or a narrowly defined selection of clips. It’s up to you to define the specifics of event 
containers.

The event container holds multiple clip containers.

 ▶	 What Should Go into an Event?

Events may store whichever clips you choose. Some editors like to create one event, 
throw all available clips into that event, and later go “gold digging” to find the nug-
gets. Other editors prefer to create multiple events, each one storing clips grouped 
by acquisition date, camera card, scene of the movie, or a subtopic within a docu-
mentary edit. Your events could represent a combination of those options because 
only you define the contents of your events.

Before you decide what to place into your events, remember that an event in Final Cut Pro 
is a virtual storage container. You may move and reorganize the clips within events to help 
you quickly locate your editing content. What is hidden from view is the powerful media 
management that Final Cut Pro performs under the hood as you import and organize files 
into those events. Events work in conjunction with the larger library container to define 
the virtual and physical locations where your source media files are stored.
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2.1-C The Library Container
A library is the largest content container in Final Cut Pro. Libraries allow you to bundle 
your events and thousands of clips for powerful yet simple management of your projects. 
Libraries facilitate the easy handoff of a project or multiple projects to another editor or 
production colleague. You need at least one library open to edit your project, and you may 
simultaneously open as many as you want.

The library container bundles events together.

In Lesson 9, you’ll further explore the media management settings and tools that apply to 
clips, events, and libraries. Those tools allow you to move, copy, and organize the source 
files within Final Cut Pro. For now, you’ll start importing clips, and see how Final Cut Pro 
handles your media when using the default media management settings.

Exercise 2.1.1 
Creating a Library
Because all the clips you’ll edit are contained inside an event, and an event is contained 
inside a library, you’ll need to create a library before you can import media. You can save a 
library on any accessible and supported local or network volume.
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1	 From the Dock or the Applications folder, open Final Cut Pro by clicking the applica-
tion’s icon.

If this is your first time opening Final Cut Pro, a “What’s New in Final Cut Pro X” 
window appears.

This window lists features that are new to the most recent update of Final Cut Pro. 
You’ll explore several new features and many others in this book. You can learn 
additional information about all Final Cut Pro features at the Final Cut Pro X Help 
webpage.
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2	 If necessary, click Continue.

The Final Cut Pro main window fills your screen, ready to edit.

The Libraries sidebar lists the open libraries in Final Cut Pro. If this is the first time 
you’ve opened Final Cut Pro, an “Untitled” library appears.

If you’ve previously opened Final Cut Pro, you may have other libraries listed. Because 
you’ll be starting a new edit using this book’s media, you should create a new library.

NOTE ▶   If you’ve used earlier versions of Final Cut Pro X, a dialog may appear ask-
ing if you want to update your existing libraries. You may choose not to update at this 
time; however, choosing to update or not won’t affect your ability to complete this 
book’s exercises.

3	 Choose File > New > Library.
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A Save dialog appears asking where to store your library. You can save a library con-
tainer to any available, supported storage device (ideally a high-speed local or net-
work volume).

4	 To display Finder options, click the disclosure triangle next to the Save As field. Navi-
gate to the same location in which you saved the FCP X Media folder.

NOTE ▶   In Lesson 1, you downloaded and moved the media to a new folder named 
FCP X Media, which you created at one of the suggested locations: an external volume, 
the Movies folder, or the desktop.

5	 In the Save As field, enter Lifted, and click Save.

In the Libraries sidebar to the left, you will see a new library, Lifted, that automatically 
contains an event named for today’s date. You also have one library that was created 
when you first opened Final Cut Pro. Let’s close that library, and any others you may 
have, to protect their contents.
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6	 Control-click (or right-click) the unwanted library, and from the shortcut menu, 
choose Close Library.

7	 Using the same method, close any additional libraries you may have listed beyond the 
Lifted library.

Closing existing libraries protects their contents while you are working with the 
materials used in this book. And don’t worry, you’ll later learn how to open existing 
libraries.

In the Libraries sidebar, look at the default contents in the Lifted library. They include 
a folder and a single event with the current date as its name. You’ll learn more about 
the organizational power of Smart Collections in Lesson 3, but for now, you’ll focus 
on getting media files loaded into the Lifted library’s event. Because you will import 
media from one of this project’s GoPro cameras into that event, rename the event to 
something more descriptive.

8	 In the Lifted library, click the text label of the event. When the text label switches to a 
text entry field, enter GoPro, and press Return.



Exercise 2.1.2 Preparing to Import Camera Source Files    21

The event is renamed. You’ve created a new library and prepared an event to receive 
the source media files as clips.

Exercise 2.1.2 
Preparing to Import Camera Source Files
For this exercise, you will mount a cloned SD card that you downloaded in Lesson 1. This 
clone will simulate a physical camera SD card.

1	 Press Command-H to hide Final Cut Pro and return to your desktop.

2	 Locate the FCP X Media folder you created in Lesson 1.

3	 Inside the FCP X Media folder, double-click the GoPro SD Card 1.dmg file.

In a moment, a removable volume icon will appear on your desktop. This software 
card simulates a physical camera card connected to your computer.

NOTE ▶   If another application opens when a card is inserted, press Command-Q to 
quit the application.

4	 To return to Final Cut Pro, click its Dock icon.
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Final Cut Pro remained in the background, awaiting your return. Depending on your 
system configuration, the Media Import window may already be open for you.

5	 If Media Import did not open automatically, click the Media Import button.

Before you import any media, you’ll examine the Media Import interface.

Reference 2.2 
Using the Media Import Window
The Media Import window presents a unified interface for ingesting source media files 
into Final Cut Pro. The Media Import window specifies where source media files reside 
and how their clip representations are cataloged within a library’s event(s). You can edit 
these clips into a project to begin your post-production workflow.

Final Cut Pro is designed to get you editing quickly by minimizing technical barricades. 
The Media Import window has four panes: sidebar, Viewer, Browser, and import options.
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▶▶ Sidebar: To the left, the sidebar lists available devices (cameras, volumes, and 
favorites) as import sources.

▶▶ Viewer: Previews the source media file selected in the lower Browser.

▶▶ Browser: Displays the source media files available for import from the device selected 
in the sidebar.

▶▶ Import options: Specifies the virtual and physical locations of clips and source media 
files during import, along with transcoding and analysis options.

The sidebar is the first pane you see when you open the Media Import window. It includes 
a list of Final Cut Pro–compatible devices.

When you select a device in the sidebar, the device’s media files appear in the lower 
Browser pane, which has two available views: filmstrip and list.

Toggle to display list view

Toggle to display filmstrip view

NOTE ▶   The available view options depend upon the selected device type.

Source media files that appear in the Browser are ready for previewing in the Viewer and 
for importing. You needn’t worry about configuring additional settings. If Final Cut Pro 
can access the file to preview it, you can import it.

Once you’ve selected which media files to import, you can turn your attention to the 
import options. The media management features of Final Cut Pro ensure that you know 
where the clips you’re about to import will be stored. You have access to incredibly power-
ful, user-configurable options with just a few clicks.
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Select the library event to virtually  
organize clips and media management  
options to physically store files.

Select the desired metadata and  
transcoding options to apply during import.

Select clip analysis and repair options.
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After setting the import options, Final Cut Pro ingests the source media files as clips that 
appear in the main window’s Browser, ready for editing. When you combine the 64-bit 
architecture of Final Cut Pro and macOS with Mac hardware, you have virtually instanta-
neous editing access to the clips, even at 4K resolution, while the import is still underway. 
Forget same-day editing. This is same-hour editing.

 ▶	 Codecs? Frame Rate? Aspect? What?

These are some of the specifications that describe media files, much as “US Letter” 
is a specification that describes paper trimmed to 8.5 x 11 inches. These three terms 
define the mathematical compression applied to each frame, the frames per second 
recorded, and the pixel size, square or rectangular.

Exercise 2.2.1 
Creating a Camera Archive
Before you start importing, you should perform one very important process: Back up your 
source media. The Create Archive command allows you to clone your source media device 
within the application that Final Cut Pro will manage and catalog. Although some editing 
workflows allow you to back up your source media files outside the application, the pur-
pose of Create Archive is to ensure that you have a backup of your original source media 
files, just in case. We’ve all deleted a file at some point that we wished we could get back.

1	 From the Cameras section of the list, select the GOPRO1 camera card.

The contents of the card appear in the Browser area. Before you start previewing the 
media files, you should begin the backup process.

2	 Below the sidebar, click the Create Archive button.
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A dialog asks you to name the new archive and choose a save location. Be sure to 
choose a meaningful name for the archive. It could be the name of the client, scene, 
project name, project number, or any combination of metadata that will later help you 
distinguish this archive from every other archive.

3	 For this exercise, type Heli Shots-GoPro to describe the files as the helicopter shots 
from the GoPro SD Card 1.

4	 If necessary, click the disclosure triangle button to display the rest of the Finder 
options.

You have the option to add the camera archive to the Favorites section of the left side-
bar for convenient access. For now, leave this option deselected.

5	 Navigate to the location of your FCP X Media folder, and click the New Folder button.

6	 Enter Lifted Archives as the new folder name. In the New Folder dialog, click Create; 
and in the previous dialog, also click Create.

A timer appears next to the GOPRO1 card in the sidebar. You may proceed with the 
importing process before the archive has completed.
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 ▶	 Why Should I Create Camera Archives?

Final Cut Pro imports source files from a variety of camera formats. For the most 
efficient import process, the Media Import window uses the source camera meta-
data. The metadata is stored among several files of the camera card/magazine, or 
is embedded in the media files. Some of the external files are hidden when viewing 
the source files in the Finder, so if you drag the source files from the card to your 
computer, you will not be copying all the associated metadata. As a result, in some 
cases, the source files will not be recognized by the Media Import window at all. 
Best practice is to clone your camera card/magazine using the Create Archive func-
tion. Creating an archive, rather than dragging files from the camera, preserves the 
camera metadata and volume structure, and allows Final Cut Pro to recognize the 
source format.

 ▶	 Where Should I Store Camera Archives?

The libraries that contain your clips should be stored on a media volume that is 
physically separate from your Macintosh HD volume. Ideally, the media volume is 
a RAID (redundant array of independent disks) volume, often referred to as a pro-
tected volume. A RAID is a group of disks bound together by hardware or software 
that presents those disks as a single volume. A RAID may be configured to provide 
data redundancy or bandwidth performance or a combination of both. If the media 
volume is your only secondary volume, storing the camera archives on the media 
volume maintains everything on one volume, which helps you to keep your edit-
ing project consolidated. However, keeping all the parts of your editing project on 
one unprotected (non-RAID) volume also creates a single point of failure. A best 
practice is to store your camera archives on a protected volume separate from your 
libraries.
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Reference 2.3 
Importing Source Media from a Camera
The Media Import window accesses a camera’s source media files, as you learned when 
creating an archive or clone of the camera card/magazine as a backup. However, creat-
ing an archive is not the same as importing files to your library. The archive is merely 
a backup of the original content. Now it’s time to import the media files as clips into a 
library event for use in Final Cut Pro.

You’ll begin by learning how to navigate the filmstrip representations of each media file. The 
mouse or trackpad is not the only way, or even the fastest way, to navigate Final Cut Pro. 
The techniques you learn here will apply throughout the rest of the application and your 
entire editing workflow. They will also help you use Final Cut Pro more efficiently.

 ▶	 Command Editor

Final Cut Pro has over 300 customizable keyboard commands that you can assign 
using the Command Editor window (Final Cut Pro > Commands > Customize).

For more information on using the Command Editor, see the “Assigning Keyboard 
Shortcuts” section of Appendix A.
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Exercise 2.3.1 
Navigating Within a Filmstrip Preview
As an independent editor, you may spend hours poring over source media files. Using 
keyboard commands to move through those materials may save only seconds at a time, 
but those seconds can compound into hours over the life of a complex editing project.

1	 With the simulated SD card still mounted, select it from the Cameras section at the 
top of the sidebar.

At the lower-right of the Browser pane, you can toggle the source file’s display view: 
filmstrip or list. Let’s start with the filmstrip view to get your first taste of skimming.

2	 Click the Filmstrip View button, if necessary.

The source media files from the cloned SD card are displayed as thumbnails, which 
you can use to quickly skim a file’s contents.

3	 Move your pointer across a file’s thumbnail to skim the media.
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A preview of the file’s contents appears in the thumbnail and in the Viewer pane 
above the thumbnails. The preview also plays the audio track if one is included in the 
file. You may also play the file in real time.

4	 With the pointer placed over a thumbnail, click the thumbnail, and then press the 
Spacebar.

The Spacebar initiates real-time file preview. Pressing the Spacebar again pauses the 
preview.

5	 Press the Spacebar again to pause playback, and then move your pointer across the 
thumbnail.

Two indicators appear on the thumbnail: the skimmer at the pointer and the playhead 
where playback stopped. You’ll learn how these indicators affect previewing and edit-
ing clips in later lessons.

You’ve already seen how you can skim a source media file to quickly preview its con-
tents. For a longer duration file, real-time playback may be too slow and skimming 
may be too fast. Using the keyboard shortcuts enables you to have precise playback 
control. The keyboard shortcuts for playback are referred to as the J K L keys.

6	 Skim to the start of GOPR0003, and then press L to start playback.

The clip plays forward at normal speed.

7	 Press K to pause, and then press J to play the file in reverse.

8	 Press J again.

The playhead moves in reverse at two times the normal speed. You can press J up 
to six times, increasing the search rate with each keypress. You can increase forward 
playback speed by pressing L.

9	 Press L a couple of times. The file plays forward, moving faster with each keypress. 
Press K to pause.
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You will later learn additional navigation controls. Now that you can navigate the 
thumbnail previews, however, you’ll learn more about the filmstrip view options.

2.3.1-A Expanding the Filmstrip View
Although filmstrip view defaults to displaying thumbnails, you may open up those thumb-
nails into an expanded filmstrip preview that allows you finer control over the skimmer 
when reviewing longer files.

1	 In the Media Import window, click the Clip Appearance button.

The stopwatch icon and the associated slider control allow you to change the display 
time scale. The time notation to the right indicates the length of playback time each 
filmstrip frame represents. The leftmost value, All, represents each source media file 
as one frame. That is, all frames of the source file are represented by a single frame 
per file.

2	 Drag the slider until the time is set to 1s.

Each frame in the filmstrip now represents one second of source media.
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NOTE ▶   When the frames representing a file extend beyond a line of frames, the 
edges of the line appear torn. The file’s filmstrip continues on the next line.

3	 Drag the slider to the left until All appears, returning the Browser to displaying one 
frame per file.

Exercise 2.3.2 
Importing Files from a Camera Card
In the following exercises, you’ll explore some import methods in Final Cut Pro. You’ll 
import media files from a GoPro camera used to shoot extra helicopter B-roll, and then 
import a batch of files, including an interview with the pilot and the bulk of the B-roll 
files.

1	 With the GOPRO1 SD card still selected in the sidebar, in the Browser, click in an 
empty gray area outside any file thumbnails. With no files selected, an Import All but-
ton is visible.

If you wanted to import all the source media files into an event as clips, you would 
click the Import All button. Alternatively, you could import only specific media files, 
ignoring any not-so-great shots.

2	 Select the GOPR0003 thumbnail.

The thumbnail is highlighted by a yellow border to indicate that the file is selected. 
You could import this file immediately by clicking the Import Selected button. But 
first, you have more files to select.
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3	 Click the GOPR0006 thumbnail.

GOPR0006 is selected, and GOPR0003 is deselected. As in macOS, you can hold down 
the Shift or Command modifier keys when clicking to select multiple items.

4	 While holding down the Command key, click GOPR0003 again to select both files.

Command-clicking allows you to select individual non-contiguous files, whereas 
Shift-clicking GOPR0003 would also include GOPR0005 in your selection. For the 
Lifted project you’ll be editing, you want to import all six GoPro files.

5	 In the Browser section of the Media Import window, click in the empty gray area to 
deselect all files.

You have indicated to Final Cut Pro that you want to import all the files on the 
GOPRO1 SD card. Now, you’ll turn your attention to the last pane of the window, 
Import Options.
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 ▶	 Importing Ranges Within a Camera File

At times, you may want to import only sections of a media file. These sections are 
known as range selections, or ranges. They allow you to import only the desired 
portions of a source media file. You have multiple ways to set a single range within 
a filmstrip preview:

▶▶ Cue the skimmer or playhead to the desired frame, and then press I to mark a start 
point. Then cue after the final desired frame and press O to mark an end point.

▶▶ Position the mouse pointer over the desired start point, and then drag to the 
desired end point. The duration information displays as you drag.

A source media file may contain useable media in multiple sections. Additional range 
selection methods allow you to mark and import more than one range within a file:

▶▶ Cue the skimmer or playhead to the start of the next desired range within the 
file, and then press Command-Shift-I to mark the additional start point. Then, 
cue after the final desired frame and press Command-Shift-O to mark the end 
point of the additional range.

▶▶ Position the mouse pointer over the desired start point, and then Command-
drag to the desired end point. The duration information displays as you drag.

NOTE ▶   Depending on the camera/video file format, range selection within a file 
may not be available.
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When marking ranges, you may need to view the source timecode from the media 
file. The Skimmer Info window, which appears above the skimmer, displays the file 
name and the source timecode. You may toggle the Skimmer Info window’s show/
hide status in the View > Browser menu, or by pressing Control-Y.

If you mark a range or ranges within a file and then decide to import only one 
range or the entire file, you may clear one range or all ranges:

▶▶ To clear a selected range, press Option-X.

▶▶ To clear all ranges, select a range of the file and press X.

Reference 2.4 
Choosing Media Import Options
The Media Import Options pane guides you through three important areas of Final Cut 
Pro clip and media management:

▶▶ The virtual storage location of clips within the interface

▶▶ The physical storage location of those clips’ source media files on accessible volumes

▶▶ The available transcoding and analysis automations

Importing Ranges Within a Camera File continued
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2.4-A Choosing Virtual Storage
The top section of Import Options defines the clip organization within Final Cut Pro. 
Because a source media file must be accessible as an event clip to be available for editing, 
the options here enable you to add clips to an existing event or create a new event for the 
clips. Let’s first look at the “Add to existing event” option.

When you select “Add to existing event,” the pop-up menu lists the events available in the 
open libraries. You may place a clip in any event inside any library.

When you select “Create new event in,” a name field enables, as does a pop-up menu for 
choosing a library in which to store the event. The naming convention you use for events 
is completely up to you. The event’s name may be as simple as the client’s name, the cur-
rent editing project, or a barcode number assigned to the raw media.

This section of the pane defines which event in the library will contain the imported clips. 
This is a virtual storage assignment that allows you to start organizing your clips for edit-
ing within Final Cut Pro. Let’s turn our attention to where the source media files for those 
clips will be physically stored.

2.4-B Choosing Physical Storage
To simplify this discussion, just remember two fundamental facts about Final Cut Pro 
libraries:

▶▶ Libraries can be physical containers storing source media files.

▶▶ Libraries also can be virtual containers referencing source media files stored outside 
the library.

Clips in Final Cut Pro may represent source media files physically stored inside the 
library, or may represent links that point to source media files stored in physical locations 
separate from the library. The location of media files is determined when you choose to 
use either managed media or external media.



Reference 2.4 Choosing Media Import Options    37

Managed media is the simplest solution for a single user, a mobile editor, or when 
archiving. You instruct Final Cut Pro to physically copy imported media files inside a 
selected library. And because you created the library earlier, you’ve already defined where 
on a volume the library and its media are stored and managed by Final Cut Pro.

Although managed media is simple to use, using external media might be the best prac-
tice for managing media within your workflow. When you’re using externally referenced 
media, source files are stored outside the Final Cut Pro libraries. External media man-
agement is recommended for workflows where the source media files are shared among 
multiple users or applications because multiple editors can access the source media files 
without interrupting other workflows. Using external media also keeps libraries small, 
which translates to faster and easier sharing when passing a library to another user with 
the same media storage access.

When importing source media files from a volume rather than a camera card, the second 
media storage option, “Leave files in place,” is available. Also known as “Edit in place,” this 
option does exactly what it suggests. No source media files are copied or moved during 
import, which leaves the files as external media outside the library.

NOTE ▶   You’ll learn more about internally managed and externally referenced media 
in Lesson 9, “Managing Libraries.”

2.4-C Generating Keywords and Assigning Audio Roles
Depending on your pre-edit organizational methods, you may spend a significant amount 
of time organizing your media files in the Finder. The Media Import options include two 
ways to tighten up your organizational efforts. Additionally, using production audio that 
supplies iXML is another organizational time-saver.
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▶▶ From Finder tags: Create and assign clips to Keyword Collections respective to the 
macOS tags assigned to those clips.

▶▶ From folders: Replicate an existing folder structure at the Finder level within the 
event using keywords.

▶▶ Assign iXML: Assign roles to audio tracks based on track metadata.

2.4-D Using Transcode and Analysis Options
More Media Import options are available in the Transcoding area. Selecting one or both of 
the transcode options creates an additional source media file for the clip.

▶▶ Create optimized media: Generate an Apple ProRes 422 version of the source file— 
a benefit for compositing, multiple effects, and reducing processing loads.

▶▶ Create proxy media: Generate an Apple ProRes 422 (Proxy) version of the source file 
with embedded audio—a compressed yet easy-to-process codec that allows you to 
store more source files on a volume.

Selecting analysis options can further automate clip sorting within the event, analyze clips 
to identify a specific technical aspect of a clip, and perform a nondestructive repair of a 
detected audio error.

NOTE ▶   You may apply transcoding and analysis options to one or more clips during 
the edit phase of your workflow.
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▶▶ Remove Pulldown in video: Applies to source media files recorded in a special frame-
cadence format.

▶▶ Analyze video for balance color: Create a one-click neutralizing correction averaged 
across the clip’s duration.

▶▶ Find people: Analyze the clip for shot composition and facial detection.

▶▶ Consolidate find people results: Average the “Find people” results based on two-
minute sections of a clip.

▶▶ Create Smart Collections after analysis: Aggregate the results of the “Find people” 
analysis into a dynamic collection.

▶▶ Analyze and fix audio problems: Nondestructively repair serious audio issues such as 
ground-loop hum or background rumble.

▶▶ Separate mono and group stereo audio: Define how source audio channels are 
combined or separated.

Clip-sorting options, such as those in the Keywords category, rely on existing or newly 
created metadata. You will learn more about metadata in Lesson 3, “Organizing Clips.”

Exercise 2.4.1 
Applying Media Import Options
Now that you’re familiar with the Media Import options, you’ll continue to import the 
camera clips. You created the library and an event for this editing project in Exercise 2.1.1. 
Now, you’ll add source media files as clips.

1	 If necessary, from the “Add to existing event” pop-up menu, choose the GoPro event 
in the Lifted library.

You’ve instructed the import process to create clips in the GoPro event to represent those 
source media files. Now you will see where Final Cut Pro will store the source media.

2	 For Files, notice that “Copy to library” is chosen.
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These source media files will become managed media files within the Lifted library, 
and the source media files will be copied from the SD card to the GoPro event stored 
in the Lifted library. Because they will be managed media files, your only concern is 
whether you placed the library on a volume with enough free space to store all the 
managed media.

3	 Deselect any other transcode, keyword, or analysis options. Click Import All.

NOTE ▶   Your Media Import Options pane should match the settings chosen in the 
Reference 2.2 section for this import exercise.

The media files for this part of the course do not need to be analyzed by any of these 
automation tools. As with the transcode options previously discussed, you may ana-
lyze any clip at any time. Doing the analysis during import is optional.

As you start the import, notice that:

▶▶ The Media Import window closes automatically when the import process is underway.

▶▶ The clips appear in the Browser with a small stopwatch that disappears after a clip is 
imported.

▶▶ You can start skimming and editing the newly imported clips.

When the import process completes, a notification appears on your display.

4	 Click the Eject button to dismiss the notification and eject the simulated SD card used 
in the exercise.

Reference 2.5 
Import Files from a Volume
If you are collaborating with someone else on a project, at some point you will need to 
import files handed to you on a volume or emailed/FTP’d to you (rather than accessing an 
original camera card containing media). Or you may receive a breaking news clip shared 
through the cloud. Like any other file for import, the received file must be in a format that 
Final Cut Pro can read and play.

NOTE ▶   See Appendix B of this book and the Supported Formats section of the 
Apple Final Cut Pro Support webpage for complete and current information on sup-
ported file formats.
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The import from a volume process starts much like importing content from the SD card:

▶▶ Mount the volume.

▶▶ In Final Cut Pro, click the Media Import button.

▶▶ Select your source device in Media Import’s left sidebar.

▶▶ Navigate to the desired file(s) in the Browser.

▶▶ Select the files for import.

▶▶ In the Media Import Options pane, the process is the same with an additional media 
storage option available.

A difference between volume and camera import will be visible in the Browser pane: 
Importing from a volume displays files in list view by default.

2.5-A Leaving Files in Place
When you imported content from the SD card, the “Copy files” option was your only 
choice. Final Cut Pro required that you copy the media files from the SD card into an 
attached volume. This requirement is a good thing. If the files were not copied, the result-
ing clips would go offline when you ejected the camera card. The offline state would have 
occurred because the clip within Final Cut Pro would still be referencing the source media 
files on the now-removed SD card.

How an offline media file appears in Final Cut Pro

When you import source media files from a volume, Final Cut Pro gives you the option to 
copy or not to copy those source files. You would copy the source media files if they were 
stored, for example, on a borrowed volume you had to return before you were finished 
editing. Copying is also a preferred choice when you import media from a shared storage 
volume to a portable volume to make your project portable.
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The second option, “Leave files in place,” does not copy the source files, but simply refer-
ences them at their current locations. This external media option is very useful in a shared 
storage environment of multiple users. It allows an editor to use the same source media files 
as other editors within the same workgroup without creating redundant copies on the server.

Beyond the slight difference in media management options, importing from a volume is 
as easy as importing from a camera.

 ▶	 Using Symlinks

When you’re using external media, the source media files are not copied into the 
library. Instead, symlinks (simulated files) are created inside the library that refer to 
the externally stored source media files. That external location may be anywhere on 
any accessible volume. Using external media files is a best practice for an editor in a 
multiuser environment.

Exercise 2.5.1 
Importing Existing Files from a Volume
In this exercise, you will import files processed and organized outside of Final Cut Pro: the 
source B-roll and sound bite files you will need for the vignette. They were copied from their 
source camera memory card and manually organized. This scenario reflects a very common 
import scenario in many genres and workflows—the importing of file/archive footage or of 
shared media.

1	 Click the Media Import button, or press Command-I.

The Media Import window opens. You will be importing from the downloaded files.

2	 Starting in the sidebar, navigate to the location of the FCP X Media folder created in 
Lesson 1.
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This location is either an external volume, your Documents folder, or your desktop. 
The necessary media is in the FCP X Media folder. Selecting your home folder in the 
sidebar is one possible starting point.

3	 Double-click the FCP X Media folder to open it and locate the LV1/LV Import folder. 
Then, open the LV Import folder to display its contents and the contents of its subfolders.

The media files have been sorted by folder. You can take advantage of this organiza-
tional structure in Final Cut Pro.

4	 Select the LV Import folder.

Now you need to set some import options.

5	 At the top of the Import Options pane, select “Create new event in,” and from the 
pop-up menu, choose the Lifted library. Type Primary Media as the event name.

Remember, you can set up the event and library to organize your media however you 
wish. Unlike the previous import, this time during import you will reference exter-
nal media that is left in place. Because you have constant access to the volume where 
the media files reside, you do not need to copy the source media.

6	 In the Files category, select “Leave files in place.”
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Another difference from the previous import method is that you will import a folder 
of media files. Final Cut Pro can import the metadata of the Finder folder structure 
using keywords. Keywords are metadata tokens applied to a clip. Keywords later may 
be used to quickly sort and find distinct or related (or unrelated) clips. This feature is 
very handy when your library contains a few hundred or a few thousand clips.

NOTE ▶   Creating keywords from macOS tags is covered in Lesson 5.

7	 From the Keywords category, select “From folders” and deselect “From Finder tags.”

NOTE ▶   The command applies keywords only when a folder is selected for import. 
Importing selected files within the folder will not apply keywords.

8	 Deselect all other transcode and analysis options, and then click Import Selected.

The Media Import window closes, and the new event appears in your Lifted library.

NOTE ▶   If necessary, dismiss a notification that the clips were successfully imported.
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9	 Click the disclosure triangle next to the Primary Media event to display its contents.

The folder you selected, and its enclosed folders, were converted into keywords. Choos-
ing the “From folders” import option copies the Finder folder structure into the event.

NOTE ▶   You will learn more about using keywords, along with other metadata tech-
niques, in Lesson 3.

 ▶	 Dragging from the Finder or Other Apps

Final Cut Pro events accept files that you drag directly from the Finder or other 
applications. But you do need to know how media import options are handled in 
these cases. When you’re dragging files directly into Final Cut Pro, the import pref-
erences control such issues as managed and external media status, transcoding, and 
analysis options.

The import preferences are found in the Final Cut Pro > Preferences menu.
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This list of import preferences should look familiar. Because dragging an item to an 
event in a library is understood as an import operation, these import options manage 
the details. Notice that the top section of the Media Import Options pane is missing. 
The library and event are defined by which item you drag to in the Libraries sidebar.

The pointer identifies which of the media storage options is active and allows you 
to override those options.

▶▶ When an item is dragged to an event, a Keyword Collection in an event, or 
the Browser, and the “Copy to library storage location” option is selected, the 
pointer displays a plus sign inside a circle.

▶▶ When an item is dragged to an event, Keyword Collection, or the Browser, and 
the “Leave in place” option is selected, the pointer displays a hooked arrow.

▶▶ If the pointer indicates a copy, you can override it and perform a “Leave in place” 
import by holding down Command-Option before releasing the mouse button.

▶▶ If the pointer indicates a “Leave in place” import, you may override it and per-
form a copy import by holding down Option before releasing the mouse button.

You’ve now imported the source media files into Final Cut Pro. You should feel good 
knowing that you can create a library and some events for getting media into Final Cut 
Pro. Although you could start editing right away with these imported files, the resulting 
clips could be numerous and unorganized. In Lesson 3, you will organize these imported 
clips for faster recall of particular clips.

Dragging from the Finder or Other Apps continued
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Lesson Review

1.	 Which of these three is the largest container: clip, event, or library?

2.	 Describe possible organizational criteria for sorting clips and projects into events.

3.	 Name and describe the built-in command for backing up camera media files.

4.	 Where should you store camera archives?

5.	 What two views are available in the Media Import window, and when are the two 
views available?

6.	 What setting on the Zoom slider in filmstrip view allows you to see each file as a 
single thumbnail?

7.	 What keyboard shortcuts or modified-skimming keys let you mark multiple range 
selections within a clip?

8.	 In the Media Import Options pane, which of these two sections sets media files as 
managed or external?

	

A					     B

9.	 Fill in the blank: With the “Create optimized media” option selected, Final Cut Pro X 
transcodes imported media to the ______ codec.

10.	 When dragging files from the Finder to an event, where do you set the option to copy 
(or not copy) the files into the library?

11.	 You are about to import source media files grouped into various folders. Which 
Media Import option must be selected to replicate the folder structure within an 
event?
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Answers

1.	 The library is the largest of the media containers.

2.	 The criteria are whatever you choose: a scene of a film, a segment of a news-magazine 
show, a webisode, stock footage, raw media from an SD card, all versions of the proj-
ects, and so on. An event is a flexible storage container that can be as all-encompass-
ing or as granularly compartmentalized as your raw media and projects.

3.	 The Create Archive command creates a clone of your source media device, preserving 
the folder structure and metadata along with the source media files.

4.	 You may store camera archives anywhere; however, to reduce the chance of a single-
point failure taking down an entire editing job, store your camera archives on a vol-
ume physically separate from the media storage volume you use for editing.

5.	 Filmstrip and list view. The two views are available when importing from a rec-
ognized camera card file structure; otherwise, only the list view is available in the 
Browser of the Media Import window.

6.	 All. The setting defines the time length represented by each thumbnail of the clip.

7.	 The keyboard shortcuts are Command-Shift-I and Command-Shift-O. Holding down 
Command while skimming a clip also marks additional ranges.

8.	 B. “Copy to library” creates managed media; “Leave files in place” creates externally 
referenced media.

9.	 Apple ProRes 422

10.	 Final Cut Pro > Preferences and select the Import pane.

11.	 From folders


